Release notes

Education software 2014
September release

About these release notes

These release notes summarize the features of the Education software 2014 June release. Use the
navigation bar on the left of your screen or the links below to access release notes for your
specific SMART education software. This document contains the release notes for the following
education software:

o SMART Notebook 14.2 software for Windows and Mac computers on the next page

o SMART Product Drivers 12 for Windows® and Mac computers on page 8

o SMART Response® 2014 assessment software on page 13

Related release notes

SMART Ink 2.x release notes (smarttech.com/kb/170570)
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SMART Notebook 14.2 software for
Windows and Mac computers

About these release notes

These release notes summarize the features of SMART Notebook 14 collaborative learning
software for Windows operating systems and Mac OS X operating system software.

Product information

SMART Notebook software sets the standard for creating, delivering and managing interactive
lessons within a single application. You can combine your favorite tools in SMART Notebook
software with your favorite tools from the Web. The new features build on the best aspects of
SMART Notebook software.

This award-winning software includes a rich set of lesson creation and delivery features and
connects you to a full ecosystem of content, tools and support. With SMART Notebook software,
all your education resources are at your fingertips, making it easy to bring your lesson materials
together and to teach with interactive content.

NOTE

SMART Notebook 14 software is available only to customers who have a valid SMART Notebook
Advantage maintenance agreement. All SMART Notebook software comes with one year of
Advantage software maintenance and users have the option to purchase extensions on a
classroom or site basis. For more information on SMART Notebook Advantage, visit

smarttech.com/advantage.

IMPORTANT

In December 2014, as part of the SMART Notebook 14.3 software release, SMART Ink and
Floating Tools are changing. The new SMART Ink will consolidate the current SMART Ink toolbar
that exists on each open window with the SMART Notebook software Floating Tools toolbar.
This will create a single-point of contact for interacting with SMART software, such as

SMART Notebook software and SMART amp™ collaborative learning software, as well as for
third-party software, such as Microsoft Office docs, web browsers and PDF readers.

Look for more details in early October 2014 at smarttech.com.
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SMART Notebook 14.2 software summary

About this release

SMART Notebook 14.2 software introduces SMART Blocks, improved math editing with the Math
Editor and improved object animation. It also resolves issues from previous releases and adds
support for one additional language for Windows® operating systems and Mac OS X operating
system software.

NOTES

« The SMART Notebook Math Tools trial isn’'t available in the Select Products window of the
Education Software 2014 September installation wizard. However, you can still activate
your purchased SMART Notebook Math Tools product key after you install
SMART Notebook software. A trial version can be installed when customizing the installation
with the SMART Install Manager. For more information, see the Education Software Installer
2014 system administrator’s guide for Windows operating systems
(smarttech.com/kb/170648).

« SMART Notebook Math powered by GeoGebra® is included in all SMART Notebook
installations.

Software component version numbers

Windows operating systems

Component Version

SMART Notebook software 14.2.953.0

Mac OS X operating system software

Component Version

SMART Notebook software 14.2.880.0

Software downloads
Download the software from smarttech.com/software.
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Minimum computer requirements

NOTE

Operating systems and other third-party software released after this SMART software might not
be supported.

Windows operating systems
« Intel® Core™ 2 Duo processor or better

¢ 2 GBof RAM

« 2.5 GB of free hard disk space for SMART education software installation (an additional
600 MB is required for complete Gallery installation)

« Windows 7 SP1, Windows 8, Windows 8.1 or later operating system

NOTE
SMART Notebook 14 software doesn’t support Windows XP operating systems. If you use

the Windows XP operating system, you must use Education Software Installer (ESI) 11.4 or
earlier.
o Microsoft® .NET Framework 4 Client Profile for SMART Notebook software and SMART Ink®
o Microsoft Visual Studio® 2010 Tools for Office for SMART Ink

« Adobe® Flash® Player 14 ActiveX® control for SMART Notebook software

« Adobe Flash Player 14 Firefox® plug-in for SMART Notebook software and SMART Response®
assessment software

« Adobe Reader® 8 or later
« DirectX® technology 10 or later

o DirectX 10 compatible graphics hardware for SMART Notebook software and 3D Tools for
SMART Notebook software

« Internet Explorer® Internet browser 8 or later

« Internet access to download Gallery content and language packs

NOTE

All prerequisite third-party software is built into the EXE file and is automatically installed in the
correct order if you deploy the smartesi2014web.exe file orthe SMART Education Software.exe
file.
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4K UHD specifications for Windows operating systems
For compatibility with displays running at 4K Ultra High Definition (UHD), the following specifications
are required:

Minimum UHD specifications Recommended UHD specifications
o Integrated GPU: Intel® Core™ i3 processor o Integrated GPU: Intel Core i3 processor
with 4 GB of RAM with 8 GB of RAM
o Discrete GPU: Intel Core 2 Duo processor o Discrete GPU: Intel Core 2 Duo processor
with 4 GB of RAM with 4 GB of RAM
NOTE

SMART recommends a DPI scaling factor of 125%.

Mac OS X operating system software
« Intel Core 2 Duo processor or better

« 2GBofRAM

« 3 GBof free hard disk space for SMART education software installation (an additional 600 MB
is required for complete Gallery installation and an additional 200 MB is required if you
choose to install all Handwriting Recognition language packs)

¢ Mac OS X 10.7,10.8 or 10.9 operating system software
« Adobe Flash Player 14 for SMART Notebook software
« Safari application program 4.0.2 or later
« Internet access to download Gallery content
4K UHD specifications for Mac OS X operating system software

For compatibility with displays running at 4K Ultra High Definition (UHD), the following specifications
are required:

Minimum UHD specifications Recommended UHD specifications

Late 2013 Retina MacBook Pro with 8 GB of Late 2013 Mac Pro
RAM

New features
e You can use SMART Blocks to explore math with your students. SMART Blocks can be
accessed from the Add-ons tab and has seven different equation types you can work with.
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« SMART Notebook 14.2 software includes several enhancements that ensure ink recognition
performs faster when you’re writing or editing equations in the Math Editor. The ink is also
more responsive and follows when the Math Editor is moved around the page.

« You can write equations in the Math Editor with colored ink.

« SMART Notebook 14.2 software improves object animation for better-looking and more
efficient interactive activities.

« Administrators can select Disable the License Status dialog box in SMART Install Manager to
prevent the License Status dialog box from appearing when users start SMART Notebook
software. They can also perform this task from the command line.

« Education Software Installer 14.2 adds Korean support for Windows operating systems and
Hungarian support for Mac OS X operating system software.

Resolved issues

General
« Youcanapply adrop cap to Asian text characters. The character formats as expected and
doesn’t appear as a black box.

« Ifyouapply alock to aninserted gallery image or a picture, the image can’t be re-sized.
Windows operating systems

o The Print Preview pane in SMART Notebook software doesn’t get cut off after you customize
text size through the Display setting in Windows operating systems.

« PowerPoint® files that contain ink objects print to SMART Notebook software as expected.
Radiating lines don’t appear on your ink annotations.

« Ifyouinstall MediaCoder onyour computer, you caninsert .flv, .asf, .avi, .mov, .mpeg, .mpg
and .wmv video files in SMART Notebook software. Without MediaCoder, you can insert .flv
video files in SMART Notebook software.

Mac OS X operating system software
« SMART Notebook software operates as expected when you use the on-screen keyboard.

e You canuse SMART Uninstaller to remove individual handwriting recognition resources.
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Known issues

General
« You’re unable to type characters with an accent when you use a third-party keyboard layout.

« You’re unable to rotate a line object after you select it and then click
Format > Lock > Allow move and rotate.

o Text grouped with other objects and text in a shape doesn’t scale correctly when you drag
and drop it into a table cell.

Windows operating systems
¢ Whenyou use SMART Document Writer on a non-English operating system to print a Word
file, the content might appear cut off in the resulting .notebook file. This happens when the
original Word file uses an A4 paper size with custom margins

+ You’re unable to disconnect an equation and a graph by clicking @. This issue occurs if
another object overlaps the @. You must right-click the equation, and then select

Math Actions > Disconnect.
« Anincorrect version of the German Lesson Activity Toolkit is installed when you perform an

update from the Gallery by pressing Show additional Gallery actions 4"?., and then selecting

Check for updates > Lesson Activity Toolkit 2.0. After you perform this update, modifications
you make to multiple choice activities won’'t be saved. This issue doesn’t occurif an
administrator performs the update with the correct German Lesson Activity Toolkit files
located at smarttech.com/administratordownloads.

« If youdouble-click a file that has two consecutive dashes separated by a space in its name,
the file doesn’t open. You must open SMART Notebook software first, and then select File
> Open.

Mac OS X operating system software
You're unable to flip ink objects left/right or up/down.

smarttech.com/support
smarttech.com/contactsupport

© 2014 SMART Technologies ULC. All rights reserved. SMART Notebook, SMART amp, SMART Ink, SMART Response, smarttech, the SMART logo and all SMART
taglines are trademarks or registered trademarks of SMART Technologies ULC inthe U.S. and/or other countries. Microsoft, Windows, Visual Studio, ActiveX,
DirectX, Internet Explorer and PowerPoint are either registered trademarks or trademarks of Microsoft Corporationin the U.S. and/or other countries. Mac, Mac
0OS, OS X, MacBook Pro, Mac Pro, Retina and Safari are trademarks of Apple Inc., registered inthe U.S. and other countries. Adobe, Flash and Reader are either
registered trademarks or trademarks of Adobe Systems Incorporated inthe U.S. and/or other countries. Pentium, Intel and Core are trademarks of Intel
Corporationinthe U.S. and other countries. SketchUp and Trimble are registered trademarks of Trimble Navigation Limited. All other third-party product and
company names may be trademarks of their respective owners. Contents are subjectto change without notice. 09/2014.

7 smarttech.com/kb/170791


http://www.smarttech.com/administratordownloads
http://www.smarttech.com/support
http://www.smarttech.com/contactsupport

RELEASE NOTES
EDUCATION SOFTWARE 2014 SEPTEMBER RELEASE

SMART Product Drivers 12 for
Windows® and Mac computers

About these release notes

These release notes summarize the features of SMART Product Drivers 12 and its service packs
and patches for Windows® operating systems and Mac OS X operating system software.

Product information

SMART Product Drivers enables your computer to detect input from your SMART Board®
interactive whiteboard or other SMART interactive product. SMART Product Drivers is included
with SMART Notebook® collaborative learning software and SMART Meeting Pro® software.

SMART Product Drivers 12 summary

About this release
This release introduces support for the SC12A controller firmware updater and resolves issues from
previous releases.

Software component version numbers

Windows operating systems

Component Version
SMART Product Drivers 12.0.563.0
SMART Ink 2.3.116.0

Mac OS X operating system software

Component Version
SMART Product Drivers 12.0.628.0
SMART Ink 2.3.111.0

Software downloads
Download the software from smarttech.com/software.
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Minimum computer requirements

NOTE

Operating systems and other third-party software released after this SMART software might not
be supported.

Windows operating systems
« Intel® Core™ 2 Duo processor or better

¢ 2GBof RAM

« Free hard disk space:

Software Space required
SMART Product Drivers 595 MB
SMART Ink 92 MB

« Windows 7 SP1, Windows 8, Windows 8.1 or later operating system

« Microsoft® NET Framework 4 Client Profile for SMART Notebook software and SMART Ink
« Microsoft Visual Studio® 2010 Tools for Office for SMART Ink

« Adobe® Flash® Player 14 Active X® control for SMART Notebook software

« Adobe Flash Player 14 Firefox® plug-in for SMART Notebook software and SMART Response®
assessment software

¢ Adobe Reader® 8 or later

« DirectX® technology 10 or later

o DirectX 10 compatible graphics hardware for SMART Notebook software
« Internet Explorer® Internet browser 8 or later

o Internet accessto download SMART software

NOTE

All prerequisite third-party software is built into the EXE file and is automatically installed in the
correct order if you deploy the smartesi2014web.exe file orthe SMART Education Software.exe
file.

Mac OS X operating system software
« Intel Core 2 Duo processor or better

¢ 2GBofRAM
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« Free hard disk space:

Software Space required
SMART Product Drivers 188 MB
SMART Ink 24 MB

« Mac OS X 10.7 (Lion), 10.8 (Mountain Lion) or 10.9 (Mavericks) operating system software
« Adobe Flash Player 14 for SMART Notebook software
« Safari application program 5.1 or later

« Internet accessto download SMART software

New features
« SMART Product Drivers 12 introduces Korean support for Windows operating systems and
Hungarian support for Mac OS X operating system software.

o« SMART Product Drivers 12 supports the SC12A controller firmware updater for SMART Board
600 series interactive whiteboards.

Resolved issues

Windows operating systems
Instructions don’t overlap or cut off when you run the LightRaise® interactive projector Initial
Setup process in German.

Mac OS X operating system software
e Touchis accurate whenyou use HID mode and Mac OS X 10.9 operating system software.
o You canaccess Check for Updates and Activation from the menu bar.

« The SMART Connection Wizard provides troubleshooting tips you can use when you receive
the “This SMART Board interactive whiteboard has limited functionality” error message.
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Known issues

General
« Youlose touch on your desktop when you’re using SMART Notebook software while
connected to an Epson® Powerlite 95 projector. To resolve this, open the SMART Board
Diagnostics Window from SMART Settings, select Tools > Advanced Board Settings > VTPC
Driver tab, and then clear the Enable VTPC Driver check box.

Windows operating systems

. You're unable to use the drawing tools in Adobe® Photoshop CS6 if the Select t toolinthe

Floating Tools toolbar is selected. As a workaround, start using the tool outside the canvas,
and then work your way onto the canvas. The drawing tool starts working after you drag it
inside the canvas.
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« You're unable to draw on the Windows desktop if you’re using a SMART Board E70 interactive
flat panel. The issue is intermittent.

« Your SMART Board 8070i interactive flat panel isn’t detected when you open Video and
Touch Input Settings in SMART Settings. You receive a “There is no SMART Board interactive
flat panel control panel detected on the USB connection” message. To work around this,
disconnect and then connect the USB cable while the error message is displayed.

Mac OS X operating system software

« The eraser onthe back of the SMART Board 6065 interactive flat panel penis too small to
erase thick ink and highlighter lines.
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« The calibration process stops responding when the progress bar indicates calibration of your
SMART Board 6065 interactive flat panel is almost complete. Reboot your computer, and
then try to calibrate your interactive flat panel again.

smarttech.com/support
smarttech.com/contactsupport

© 2014 SMART Technologies ULC. All rights reserved. SMART Board, SMART Notebook, SMART Meeting Pro, SMART Ink, LightRaise, SMART Podium, DVIT,
SMART Response, smarttech, the SMART logo and all SMART taglines are trademarks or registered trademarks of SMART Technologies ULCinthe U.S. and/or
other countries. Windows, Microsoft, Visual Studio, ActiveX, DirectX and Internet Explorer are either registered trademarks or trademarks of Microsoft
Corporationinthe U.S. and/or other countries. Mac, Mac OS, OS X and Safari are trademarks of Apple Inc., registered inthe U.S. and other countries. Adobe, Flash
and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated inthe U.S. and/or other countries. Pentium, Intel and Core are
trademark of Intel Corporationinthe U.S. and other countries. All other third-party product and company names may be trademarks of their respective owners.
Contents are subjectto change without notice. 09/2014.
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SMART Response® 2014
assessment software

About these release notes

These release notes summarize the changes in SMART Response® assessment software.

Product information

The SMART Response interactive response system is available in several models to suit a variety
of learning environments, such as 1:1, K-12, early education, special needs and advanced math and
science. SMART Response assessment software enables you to create, deliver and instantly track
quiz results and lesson comprehension to gain immediate insight into student learning and to help
increase overall retention and engagement. You can assign different point values to individual
questions and tag student names and assessment questions with key words.

With Teacher Tools, you can view and manage all your assessment data from one location. After
you quiz students, the Teacher Tools Gradebook gives you quick access to assessment results,
making it easy to prepare reports on student and class progress.

SMART Response 14.1 software update

About this release
This release includes bug fixes.
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Software component version numbers

Windows operating systems

Component Version

SMART Response software 14.1.798.0

Mac OS X operating system software

Component Version

SMART Response software 14.1.715.0

Software downloads
Download the software from smarttech.com/software.

Minimum computer requirements

Windows operating systems

14

Pentium® 4 processor or better
4 GB of RAM

2.5 GB of free hard disk space for SMART education software installation (an additional
600 MB is required for complete Gallery installation)

Windows 7 SP1, Windows 8, Windows 8.1 or later operating system

NOTE

SMART Notebook 14 software doesn’t support Windows XP operating systems. If you use
the Windows XP operating system, you must use Education Software Installer (ESI) 11.4 or
earlier.

Microsoft® NET Framework 4 Client Profile for SMART Notebook software and SMART Ink®
MicrosoftVisual Studio® 2010 Tools for Office for SMART Ink
Adobe® Flash® Player 13 ActiveX® control for SMART Notebook software

Adobe Flash Player 13 Firefox® plug-in for SMART Notebook software and SMART Response®
assessment software

Adobe Reader® 8 or later

DirectX® technology 9 or later
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o DirectX 9 compatible graphics hardware for SMART Notebook software and 3D Tools for
SMART Notebook software

o Internet Explorer® Internet browser 8 or later
« Internet access to download Gallery content and language packs

NOTE

If you don’t have the Microsoft NET Framework 4 Client Profile, the Adobe Flash Player 13
ActiveX control or the Adobe Flash Player 13 Firefox plug-in, the installation wizard installs
these components.

Mac OS X operating system software
« IntelCore 2 Duo processor or better

« 2 GBof RAM

« 3 GBof free hard disk space for SMART education software installation (an additional 600 MB
is required for complete Gallery installation and an additional 200 MB is required if you
choose to install all Handwriting Recognition language packs)

« Mac OS X 10.7,10.8 or 10.9 operating system software
« Adobe Flash Player 13 for SMART Notebook software
« Safari application program 4.0.2 or later

o Internet access to download Gallery content

New features
No changes from previous release.

Resolved issues
Cloned Notebook page questions are marked correctly on response.smarttech.com

Known issues
No changes from previous release.

smarttech.com/support
smarttech.com/contactsupport

© 2014 SMART Technologies ULC. All rights reserved. SMART Response, SMART Notebook, SMART Ink, smarttech, the SMART logo and all SMART taglines are
trademarks or registered trademarks of SMART Technologies ULC inthe U.S. and/or other countries. Windows, Microsoft, Visual Studio, Internet Explorer,
ActiveX and DirectX are either registered trademarks or trademarks of Microsoft Corporationin the U.S. and/or other countries. Mac, Mac OS, OS X and Safari are
trademarks of Apple Inc., registered inthe U.S. and other countries. Adobe, Flash and Reader are either registered trademarks or trademarks of Adobe Systems
incorporated inthe U.S. and/or other countries. Pentium, Intel and Core are trademarks or registered trademarks of Intel Corporation or its subsidiaries inthe U.S.
and other countries. All other third-party product and company names may be trademarks of their respective owners. Contents are subjectto change without
notice. 09/2014.
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